Microscan AutoVision 3	Developing custom dotNET interfaces with VS2010	C# Edition
Loading and Running Jobs
Loading and Running Jobs, Receiving Results and Images
In this C# example we will walk you step by step through the process of building a very simple user interface. This example will demonstrate the following:
• Loading a Job (AVP file) from Disk.
• Connecting that Job to a Visionscape smart camera.
• Running the Job.
• Creating a report connection to handle images and results.
• Displaying the images and results at runtime.

Minimum requirements
· Visual Studio 2010 (newer versions not yet tested but there are concerns about the .NET framework version 4.5)
· .Net Framework version 3.5 or 4.0 (see above)
· VisionHAWK or VisionMINI, or Microscan GigE with Visionscape license*(or Device Independent setup)

Getting Started
– Launch Visual Studio 2010 (or Visual C# 2010 Express).
– From the File Menu, choose “New Project…” (or “New Project…” from the Start Page.)
– In the New Project dialog, choose “Visual C#” as your language, and then choose “Windows Forms Application” as your project template type.
– Choose the location for your project and .Net4 Framework for the type.
– Enter “dotNET_LoadAndRun” for the project name, and press OK.
Add References to your project
– Go to the Project menu and select “Add Reference…”. In the “Add a Reference” dialog, under the “.NET” tab, add references to the following Visionscape assemblies:

Visionscape.dll
Visionscape.Communications.dll
Visionscape.Devices.dll
Visionscape.Steps.dll

(Note that you can also add references by right-clicking on the References folder in the Solution Explorer)

If you cannot see the Visionscape references under the “.NET” tab then the assemblies did not get registered correctly. This is something Microscan are working on and will be addressed in a future release. In this case you can browse to the references which are in C:\Microscan\Vscape\Assembly
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We also need to add a few more references from the display folder as shown below
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Go to the Properties for the Visionscape.dll reference clicking on the Visionscape reference in the Solution Explorer.
Change the following:

	Property Name
	Value

	Embed Interop Types
	False
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This will cause the value of the property “Copy Local” to change from False to True.

Do the same for the two references “Interop.MSComCtl2” and “Interop.MSFlexGridLib”.

Add Visionscape custom controls to your project
– Go to the View menu and select “Toolbox”. This will show the toolbox panel on the left-hand side of the window. If Visual Studio 2008 was installed on your PC when you installed Visionscape, then you should have a tab named “Visionscape”, and it will contain all of the visual components provided by Visionscape. 

If you are using Visual Studio 2010 the install methods above won’t work. You have to do it as follows:

1 Make sure your project is open (follow the steps above)
2 In windows, navigate to C:\Vscape\Assembly\Display
3 Select all the items in the folder
4 Drag them onto Visual Studio.

The only difference from here on down is that there won’t be a Visionscape group in the toolbox, all tools will be under All Windows Forms.

Rename the Main Form

– Change the name of “Form1” in your Project to “frmMain”

• Change the following property:

	Property Name
	Value

	Text
	Whatever you want to call it




Add Components to the Main Form

In this example we will display an image using our BufferView control, and we will display the uploaded inspection results using our ReportView control. We will insert the two controls into a Splitter Control, so the user can adjust the size of each.


Add Split Containers, BufferView and ReportView
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– Add a “Split Container” control to the main form. This control is found in the “Containers” tab of the ToolBox, as shown above. The new control, by default called “splitContainer1” will automatically fill the form. Add a second split container in the right-hand side of the first one and change orientation from vertical to horizontal.

– Drag a BufferView control from the Toolbox to the top panel of the horizontal SplitContainer. This can be found in the “General” tab of the Toolbox, as shown below:
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• Change the following properties:

	Property Name
	Value

	(Name)
	ctlBufView

	Dock
	Fill



– Drag a ReportView control from the Toolbox to the lower panel of the horizontal SplitContainer. We will use this to display reports from the running inspections. This component is also found in the “General” tab of the Toolbox, as shown below:
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• Change the following properties:

	Property Name
	Value

	(Name)
	ctlReportView

	Dock
	Fill



The form should now look similar to this
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Note that the ReportView is a complicated COM object in a dotNET wrapper. This will cause some problems later on in this project. Most Visionscape components are similar in that they are not true dotNET objects but the ReportView is particularly difficult for Visual Studio to dissect in order to work out its dependencies.


Add the Code
[bookmark: _GoBack]
Go to the frmMain code window. At the top of the file, we will add the following “using” statements for the various Visionscape namespaces we will be accessing:

using Visionscape;
using Visionscape.Steps;
using Visionscape.Devices;
using Visionscape.Communications;

At the top of the frmMain class, add the following member variables:

    public partial class frmMain : Form
    {
        //////////////////////
        //MEMBER VARIABLES
        //VsCoordinator tells us what hardware is available
        VsCoordinator m_Coord;
        VsDevice m_Dev; //will hold a ref to the chosen Device
        JobStep m_Job; //A JobStep loads and saves AVPs
        VisionSystemStep m_VS; //the VisionSystem step
        //We will use this object to receive images and results
        //from the inspection
        ReportConnection m_repcon;
        //reference to the most recent inspection report
        InspectionReport m_report;
        //We will use this to save/restore application settings
        Properties.Settings m_appsettings;

Application Startup

When our application starts up, we will load one of the Sample Jobs that is installed with Visionscape. We will connect it to the Software System in your PC (always created) and then prepare it to run. In frmMain’s Load event, we will need to do the following:

1. Instantiate our VsCoordinator and JobStep objects.
2. Load the Job from disk.
3. Get a reference to the Software System.
4. Connect the Job to the Software system by downloading to it.
5. Connect our report connection, so we can receive images and results at runtime.
6. Run the inspection.

Add an event handler for frmMain’s Load event from the frmMain Properties – Events window
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, and add the following code:

       private void frmMain_Load(object sender, EventArgs e)
        {
            //instantiate our coordinator and Job Step
            m_Coord = new VsCoordinator();
            m_Job = new JobStep();
            try
            {
            //load the sample AVP
            m_Job.Load("C:\\Microscan\\Vscape\\Tutorials And Samples\\Sample Jobs\\Wrench Gauge\\example_wrenchgauge.avp");
            //Now get a reference to the Software system
            m_Dev = m_Coord.FindDeviceByName("SoftSys1");
            //connect the job to hardware
            m_Dev.Download(m_Job.VisionSystemStep(), true);
           //Connect our report connection
            ConnectReport();
            //Start the inspection running
            m_Dev.StartAll();
 		}
            catch (Exception ex)
            {
            MessageBox.Show("Exception thrown while starting up:" + ex.Message);
            this.Close();
            }
        }

Note the double “\\” characters in the job name. This is required for C# to process the”\” inside a string.

At this point you will see an error in the Error List window alerting you that ConnectReport does not exist. We’ll take care of that next.

Making Report Connections

Add the ConnectReport function that we are calling from frmMain_Load. This function will instantiate our ReportConnection, connect it to our device, and configure it to upload images.

        private void ConnectReport()
        {
            //Create a report connection
            m_repcon = new ReportConnection();
            //Connect it to the first inspection on our device
            m_repcon.Connect(m_Dev, 1);
            //We want images to be included in our report,
            //so add them now.
            //Find the first Inspection step
            InspectionStep insp = m_Job.VisionSystemStep().FindByType("Step.Inspection")[1] as InspectionStep;
            //Add all snapshot buffers in this inspection to the report
            m_repcon.AddSnapBuffers(insp);
            //lastly, we need to wire up our event handler
            m_repcon.NewReport += m_repcon_NewReport;
        }

Now you’ll see an error letting you know that m_repcon_NewReport doesn’t exist.

Handling Reports

Now that we can receive reports, in this section we will add the code to handle them. Our NewReport event handler will receive an inspection cycle report, and we will then display the first image in our BufferView control, and display the inspection data in our ReportView.

        //This event will be received after every inspection cycle
        void m_repcon_NewReport(object sender, ReportConnectionEventArgs e)
        {
            InspectionReport report = e.Report;
            //display the first image in our BufferView control
            if (report.Images.Count > 0)
            {
                ctlBufView.Buffer = report.Images[0] as BufferDm;
            }
            //display the report data in our ReportView control
            ctlReportView.Report = report;
        }


Handling Application Shut Down

When our application shuts down, we need to make sure that we stop the running inspection and disconnect our ReportConnection. It is also good practice to clean up the job and device references we created in frmMain_Load. To do this,create a frmMain_FormClosing event handler in the Properties window add the following code to the new event handler:


       private void frmMain_FormClosing(object sender, FormClosingEventArgs e)
        {
            // Stop the running inspection if any
            if (m_Dev != null)
            {
                if (m_Dev.IsAnyInspectionRunning)
                    m_Dev.StopAll();
                // we could put a small pause in here to make sure that everything 
                // has stopped. If we happened to call this during an inspection then 
                // that inspection will still have to finish and send a report. I've 
                // added a second here.
                System.Threading.Thread.Sleep(1000);

                // clean up the report connection AFTER stopping the inspection
                // to make sure that we don't miss any inspection results.
                if (m_repcon != null)
                {
                    if (m_repcon.IsConnected)
                        m_repcon.Disconnect();
                }

                // disconnect the job from the device
                m_Dev.Disconnect();

                // clean up the job object
                if (m_Job.Count > 0)
                    m_Job.Remove(1);
            }
        }


Compile and Run

You should now be able to run the project. When your application runs, Windows will probably warn you about it. 
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Click on Allow Access and you should see something like this:
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Why no images? If you look in the debug window you’ll see that all the images referenced in the job are either missing or corrupt! That’s because the job is using C:\Vscape instead of C:\Microscan\Vscape. I suspect that all of the tutorials and samples will need to be updated.

[image: ]


Congratulations! You written a working dot NET application that interfaces to Visionscape. 



Making your Visionscape Applications more tolerant of unexpected events.

Waiting for Device Discovery.

When the application starts we should wait until the device we want to use has been discovered. If the Visionscape Backplane is not running when your application starts then this can take some time. To wait for device discovery, we will add the following code to frmMain_Load

        private void frmMain_Load(object sender, EventArgs e)
        {
            //instantiate our coordinator and Job Step
            m_Coord = new VsCoordinator();

            // ADVANCED - Wait for Device Discovery
            //wire up our event handler to the OnDeviceFocus event
            m_Coord.OnDeviceFocus += OnDeviceFocusEventHandler;
            //tell coordinator to fire the OnDeviceFocus event when
            //the device MyHawkEye_1600T is discovered
            m_Coord.DeviceFocusSetOnDiscovery("SoftSys1", -1);

and then add a new event handler as follows:

        private void OnDeviceFocusEventHandler(VsDevice objDevice)
        {
        m_Coord.LogMessage("Our Device has been Discovered and is Ready to use",false);
        //Continue your UI initialization here…
        }

Note that we have also used a method in the VsCoordinator object to send a message to be printed in the Visionscape Backplane Debug Window. This is useful when debugging code or, if the second argument is set to True the window will pop up in front of your application so you can alert users of potential problems.

Build and try your code again.



Deploying your application on a target machine

The application here is obviously not much more than a simple monitor. However, installing this on your target system is the same as installing a much more complex app. Visual Studio 2010 provides a Publish button in the Build menu which will give you a folder containing an installer. This is simple. Visual C# Express does not give you this abililty but it is possible to take the entire build folder (for instance, C:\Microscan\Vscape\dotNet Samples\dotNet_LoadAndRun\dotNet_LoadAndRun\bin\Debug ) and copy this onto the target system as this should contain everything that is needed to run the application. 

This is a change from Visual Studio 2008, Visual Studio 2010 and the newer dotNet version tries to encapsulate everything that an application needs in one place rather than relying on having the correct version of every dll somewhere else on a PC. This should make it more robust and it certainly makes deleting a VS2010 built application much easier – just move the directory into the Trash. 

For our simple application above, the build directory contains the following items:

[image: ]


If you double-click on the dotNet_LoadAndRun application on your build machine it will run just fine. However, it will not run on another machine because of a problem with the ReportView control which results in a required dll not being copied into the folder. The file required is stdole.dll and, on machines with the Microsoft.NET framework installed (and it will have to be if you want to use your code) this dll can be found in

C:\Program Files\Microsoft.NET\Primary Interop Assemblies

Properties of this dll will be similar to those shown below.

[image: ]

If you copy this file into your build directory and then copy this to your target machine (which must have Visionscape 5.x installed) then you should be able to run your application.



Accessing Inspection Results

Displaying results in a container like the ReportView used in the first example is one thing but most users are likely to want to pass individual results on to other pieces of code in order to act on the data received.
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